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Preface - About This Book

This book describes the IBM BookManager Build for Windows V2.3 licensed program 
and how to install and use it to build softcopy books.

What You Should Know Before Reading This Book 
You should be familiar with terminology associated with your word-processing 
program. You should also be familiar with the Microsoft Windows platform your using 
(such as: Microsoft Windows NT, V4.0 or later, or Windows 95, 98, 2000, or ME) to 
perform tasks such as:

• Moving, sizing, and closing windows

• Entering information into entry fields

• Selecting icons, menu choices, radio buttons, push buttons, and check boxes

• Selecting items from lists

How This Book Is Organized
Table 1 shows where you can look in this book for information about getting started 
with Build for Windows: 

Note:  This book also contains a Glossary of terms

  

 

Table 1. Getting started information.

If you want to: See:

Learn what BookManager Build for 
Windows is and what it does

Chapter 1, “Introduction to Build for Windows V2.3” on 
page 1 

Install BookManager Build for 
Windows 

Chapter 2, “Installing Build for Windows” on page 5

Start BookManager Build for 
Windows 

 Chapter 3, “Starting Build for Windows” on page 11

Read basic information about Build 
for Windows files 

Chapter 4, “Working with Build for Windows Files” on 
page 13

Get detailed information on using 
Build for Windows

Chapter 5, “Using Build for Windows” on page 17

 Call IBM Service Chapter 6, “Build for Windows V2.3 Program Service” 
on page 37

Learn how to build a softcopy book 
with the help of step-by-step 
instructions.

Appendix A, “Guide for Building Softcopy Books with 
BookManager Build for Windows 2.3” on page 39

See the list of sample files included 
with Build for Windows V2.3

Appendix B, “Sample Files Shipped with BookManager 
Build for Windows 2.3” on page 49
© Copyright IBM Corp.  1989, 2002  ix



 

Conventions Used in This Book
When new or unfamiliar terms are introduced, they appear in italics. A definition for the 
term follows in the text. Definitions for the italicized terms, as well as for abbreviations, 
appear in the glossary.

The following items appear in bold typeface:

• Titles, entry field names, and other text that Build for Windows displays

• Items that you are to type or select

• The names of keys on your keyboard

Terms Used in This Book
The following terms have specific meaning in this book:

BookManager Build

A set of IBM licensed programs that lets you create softcopy books. BookManager 
Build is available on the following platforms: MVS, VM, and Windows. In this book, the 
term BookManager Build refers to any BookManager Build program. 

BookManager Readers

In this book, the term BookManager Readers refers to any BookManager READ 
programs. 

• IBM BookManager Read for VM and MVS (host-based systems, such as z/OS, 
System 390 and MVS)

• IBM BookServer for z/OS, AIX, Linux, and Windows (allows you to read 
BookManager books on the Web)

• IBM Softcopy Reader for Windows and Linux
IBM Softcopy Reader is a Java-based online documentation reader and organizer 
made up of two programs:

— Book Reader
Book Reader allows you to open softcopy books created with one of the IBM 
BookManager Build programs. You can view and navigate through softcopy 
books, do searches within the book, create notes, copy text, print text 
selections, a section, or the entire book.

— Bookshelf Organizer
Bookshelf Organizer allows you to manage your books and bookshelves in 
the following ways:

– Specify the location (paths) of all books and bookshelves located on your 
workstation, on a network, or an external storage device 

– Organize your bookshelves by name, date, or description 

– Organize your books by name, date, description, or document number 

– Create your own bookshelves

– List bookshelves 

– Delete bookshelves 

– Import books into a bookshelf 

– Search bookshelves or selected books

– Move books between bookshelves 
 x IBM BookManager Build for Windows: Getting Started  Version 2 Release 3  



Build Configuration File

The Build Configuration File is a file containing the build settings. This file has the 
extension .bcf.  In Version 2.2, it was referred to as Notebook or Build Notebook.

Build Style Mapping File

The Build Style Mapping File is a file that contains the rules for mapping source 
document styles to book styles. This file has the extension .bsm. In Version 2.2, it was 
referred to as Rules or Rules Notebook.

Source document

An input file that can contain text, formatting codes, and artwork. A source document 
can be edited, printed, viewed, or used as input to a licensed publishing program such 
as BookManager Build. The source documents you can build using BookManager 
Build for Windows are described in 1.1 “Source Document Types You Can Use to 
Build Softcopy Books” on page 2. 

Build

To create a softcopy book from a source document. 

Where to Find More Information
More information about Build for Windows can be found in the following: 

• Online Help - Read the online help to get specific information about Build for 
Windows functions and procedures. 

• IBM BookManager Build for Windows: Messages and Codes - This softcopy book 
describes the messages and codes that appear when you build softcopy books. 

• Sample source documents (called template files) are included with the Build for 
Windows product. They are intended to simplify the tasks of generating your own 
source documents and creating a style mapping file. For each template file, Build 
for Windows also provides a style mapping file. See 1.3.1 “Using Template Files to 
Help Create Source Documents” on page 3 for additional information on the 
templates. 

Where to Find More Information about BookManager
On the World Wide Web, check out:

 http://www.ibm.com/software/office/bkmgr

This page gives you everything you want to know about BookManager products, how 
to order them, how to obtain service, and what's new in the BookManager product 
family.    
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Chapter 1. Introduction to Build for Windows V2.3

The BookManager Build for Windows V2.3 licensed program is part of the IBM 
BookManager family of products. With Build for Windows, you can convert a formatted 
source document created with a word-processing program to a softcopy book. You 
can view a softcopy book with IBM Softcopy Readers and IBM BookManager 
Readers. The types of source documents you can use with Build for Windows are 
listed in 1.1 “Source Document Types You Can Use to Build Softcopy Books” on page 
2.

The following illustrates the relationship between your word processor documents, 
BookManager Build for Windows, and the IBM Softcopy Readers and BookManager 
Readers.

BookManager Build for Windows

Build for Windows lets you take a formatted document, created on a PC-workstation 
word processing program, and convert it into an electronic "softcopy" book.

IBM Softcopy Readers and IBM BookManager Readers

Allow you to use the softcopy book online:

• View and navigate a book

• Create and manage softcopy book shelves and libraries

• Search books, bookshelves, and libraries

• Print book topics

• Cut and paste book topics

This chapter describes the following topics:

• Source document types you can use to build softcopy books

• How softcopy books are similar to printed documents
© Copyright IBM Corp.  1989, 2002  1



 

• How you can view softcopy books

• Before you start using Build for Windows 

1.1 Source Document Types You Can Use to Build Softcopy Books
With BookManager Build for Windows, you can build softcopy books from source 
documents prepared using any of the following products or file types: 

• Adobe FrameMaker, Versions 4.0, 5.0, and 6.0 (in .MIF format). 

• Corel WordPerfect for DOS, Versions 5.0, 5.1, and 6.0.    

• Corel WordPerfect for Windows, Versions up to and including 9.0.    

• Lotus Ami Pro for Windows, Version 3.0, Version 3.1 for Windows

• Lotus WordPro, Version 9.6 and earlier

• Microsoft Word for DOS, Versions 5.0, 5.5, and 6.0.

• Microsoft Word for Windows, Version 6.0 (Word95), Version 7.0 (Word 97), and 
Word2000.   

1.2 How Softcopy Books Are Similar to Printed Documents
When you view a softcopy book, you may notice the following similarities with your 
printed document: 

Topics                                                                                                                                    
Both printed documents and softcopy books contain topics. A softcopy book    
does not contain pages, so topics are the basic BookManager information 
units. A topic consists of a heading and all the subsequent text up to the next    
heading or subheading. All references (such as index or table of contents    
entries) in a BookManager book refer to topics instead of pages.       

Front matter
                                                                                                                   Printed 
documents and softcopy books usually contain front matter, such as    a table 
of contents, list of figures, and list of tables. When Build for Windows creates 
these front-matter document elements, BookManager Read functions, such 
as hypertext links from the table of contents (described below) and the book-
description function, become available.       

Hypertext links    
                                                                                                        Printed 
documents contain references to page numbers and headings. In a    softcopy 
book, hypertext links connect information. When you view a softcopy    book 
with BookManager Readers, certain words and phrases are highlighted. You 
can go directly to another part of the book that contains information 
associated with the highlighted word or phrase by:    

• Double-clicking on the highlighted word or phrase (READ/6000 or READ 
for Windows)      

• Moving the cursor to the highlighted word or phrase and pressing      
Enter 

For example, you can move from a table caption in the List of Tables directly to 
the table itself, or from an index entry directly to the index reference in the 
book.       

Artwork    
                                                                                                                               Many 
printed documents contain artwork. In a softcopy book, a graphics reference 
link, such as PICTURE 3, appears and is highlighted where your artwork 
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normally appears in a printed document. When you read the softcopy book, 
you can display the artwork by:    

• Double-clicking on the graphics reference link. Note: You have the 
capability to display pictures integrated into the text with all of the 
workstation readers (IBM Softcopy Reader, all of the BookServers, and 
READ for Windows).      

• Moving the cursor to the graphics reference link and pressing Enter 

 

Back matter    
                                                                                                                  Softcopy 
books, like printed documents, can contain back matter such as    appendixes, 
a glossary, and an index. When Build for Windows creates an index, hypertext 
links between the index entries and index references become available. 

1.3 How You Can View Softcopy Books
You can view softcopy books with any of the readers listed. When you read the 
softcopy book, you can search for information, make notes, and perform other tasks. 

• IBM Softcopy Reader for Windows 

• IBM Softcopy Reader for Linux

• BookManager READ/MVS Version 1.3    

• BookManager READ/VM Version 1.3    

• BookManager BookServer for the World Wide Web for AIX and Linux 

• BookManager BookServer for the World Wide Web for Windows

• BookManager BookServer for the World Wide Web for z/OS

Note: On the AS/400 platform, you can use InfoSeeker, the AS/400 implementation of 
the BookManager Read product family, to access and view books. InfoSeeker is a part 
of the OS/400 licensed program, Version 3 Release 1 or later. If you have the IBM 
Softcopy Reader installed on your workstation, you can have Build for Windows 
access the Softcopy Reader automatically after building a softcopy book. See 
5.2 “Build Options Window” on page 21 for information on how to start BookManager 
READ programs. 

1.3.1 Using Template Files to Help Create Source Documents
Sample source documents (called template files) are included with the Build for 
Windows product. They are intended to simplify the tasks of generating your own 
source documents and creating the style mapping file. For each template file, Build for 
Windows also provides a style mapping file.   

Which template to use

  
Table 1-1. Template Files

Word processor Template Style Mapping File

Adobe FrameMaker TEMPMKR.MIF TEMPMKR.BSM

Corel WordPerfect 6 and earlier TEMPWP6.DOC TEMPWP6.BSM

Corel WordPerfect 7 and later TEMPWPT.DOC TEMPWPT.BSM

Lotus Ami Pro TEMPAMI.SAM TEMPAMI.BSM 

Lotus WordPro TEMPLWP.LWP TEMPLWP.BSM
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Using the template Build Configuration and Build Style Mapping files

The template files can be a good starting point for creating your own Build 
Configuration and Build Style Mapping files. To do this, open the desired template file, 
make the changes necessary to build your book, then save the Build Configuration or 
Build Style Mapping file as a new file. You will not be able to save changes directly to 
the template files.

Microsoft Word 95 TEMPMS6.DOC TEMPMS6.BSM

Microsoft Word 97 and later TEMPMSW.DOC TEMPMSW.BSM

Table 1-1. Template Files

Word processor Template Style Mapping File
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Chapter 2. Installing Build for Windows

This chapter describes how to install Build for Windows. The following topics are 
described in this chapter: 

• Requirements for installing Build for Windows    

• Migration from BookManager Build for Windows Version 2.2 to Version 2.3

• Installing the Build for Windows program 

• Using the Conversion Utility

2.1 Requirements for Installing Build for Windows 
Before installing Build for Windows, check to see that the following hardware and 
software resources are available: 

• Any system unit capable of running Microsoft Windows NT, V4.0 or later, or 
Windows 95, 98, 2000, or ME. A 266MHZ processor or higher is recommended.    

• Display monitor    

• Any pointing device    

• One CD-ROM device    

• 64MB of RAM in addition to that required by the operating system    

• 40MB of hard-disk drive storage in addition to that required by the operating 
system    

• A temporary file space of 5x the size of the word processor file you are currently 
building is needed 

2.1.1 Software Requirements
• Microsoft Windows NT, V4.0 or later, or Windows 95, 98, 2000, or ME

• Sun Java 2 Runtime Environment 1.3.0 or later

• IBM Softcopy Reader for Windows 2.3.5 or later to view the online help, and view 
and verify the books you create with BookManager Build for Windows. 

• A supported word processor file type 

2.2 Migration from BookManager Build for Windows Version 2.2 to 
Version 2.3

BookManager Build for Windows Versions 2.2 and 2.3 cannot be installed on the 
same computer. If Build for Windows 2.2 is currently installed on your computer and 
you want to install Version 2.3, you have two options. 

• Manual installation - you can manually uninstall Build for Windows Version 2.2, 
then install Build for Windows Version 2.3

• Automatic installation - install Build for Windows 2.3 and let it automatically 
uninstall Build for Windows Version 2.2

With either option, the Build for Windows 2.2 uninstall procedure is invoked to uninstall 
Version 2.2. This process will remove all Build for Windows Version 2.2 files and 
'Sample' files that followed the original install path to, and including, the 'BIN' directory. 
As an exception, all customer files located within this path will NOT be removed. Any 
customer files located in the 'BOOK', 'NOTEBOOK', 'RULES', 'SOURCE', and 
'WORKING', directories will be preserved. If you have changed any of the original 
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'Sample' files then they must be preserved by renaming, copying, or moving to 
another path.

Upon the installation of Build for Windows 2.3, any Version 2.2 'Sample' Template 
Files, ’NOTEBOOK’ and ’RULES’ directories, that are found will be replaced with the 
new 2.3 'Sample' Template Files, thus creating new versions of these files. Not all of 
the original 2.2 files may be preserved, so if changes have been made to the original 
2.2 Template Files they must be 'SAVED' elsewhere. In addition, BookManager Build 
for Windows 2.3 will convert any Template Files it finds within the install path from the 
2.2 format to the new 2.3 format. The 2.2 file(s) will be converted creating new 2.3 files 
while preserving the original file.

The BookManager Build for Windows 2.2 install path may remain after uninstalling 
Version 2.2 because of the retention of customer data and/or other circumstances.   If 
so, Build for Windows 2.3 will be installed using the original Version 2.2 install path. 
Otherwise, Version 2.3 will install in a new path structure.   

2.3 Installing BUILD for Windows Program
Installing from a CD-ROM

1. Insert the BookManager Build for Windows CD in your CD-ROM drive.

2. On the Windows Task Bar, click on Start->Run 

3. In the Run window, click on Browse

4. In the Browse window, navigate to the CD-ROM drive, then pick the Buildwp 
directory, followed by the directory of the desired language. For example, to install 
an English version of Build for Windows from a CD-ROM drive labeled g, select 
the following: 
g:\buildwp\enu\

5. Select Setup.exe, and click on Open

6. Back in the Run window, click on OK

7. Follow the instructions on your screen.

Installing from a download

1. Download BookManager Build for Windows 2.3. You can download either the full 
program with the latest service updates, or just the CSD (Corrective Service 
Diskette) - the latest service update.
For the latest CSD, go to:
http://www.ibm.com/software/office/bkmgr

2. Double click on the download file

3. Follow the installation instructions on your screen.

Note:  If you are upgrading a previously installed Build for Windows 2.3 program, 
your original settings will be retained by the program. You can restore the Build 
for Windows 2.3 default settings at any time, by deleting the build.ser file. This 
file is located in the \bin directory in the Build for Windows 2.3 installation path. 
For example, if you used the default settings when you installed the Build 
program, the \bin directory will be located at: C:\Program 
Files\Ibm\BookManager\Build\Bin. 
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2.4 Using the File Conversion Utility
Build for Windows V2.3 uses the XML standard to make its Build Configuration 
Notebook and Build Style Mapping Rules files more human and computer readable as 
well as to provide for better error checking. A conversion utility has been included as 
part of Build for Windows 2.3 to convert your Build for Windows 2.2 Notebooks and 
Rules files to the new format. The rest of this section descries how to use the 
Conversion Utility.

2.4.1 Converting V2.2 Files
To start the Conversion Utility, select File Conversion Utility from the IBM 
BookManager Build group on the Start Menu. The Conversion Utility window will 
appear as follows.

Figure  2-1. BookManager Conversion Utility Window

• Source Directory - This is the directory that will be searched for Version 2.2 files 
(Notebook .nbk and Rules .rul). Any such files found will be converted. The 
Browse Button can be used to select a directory from the File System. Note: The 
V2.2 files will not be automatically removed.

• Target Directory - This is the directory any converted files will be placed. This can 
be the same as the Source Directory. The Browse Button can be used to select a 
directory from the File System.

• Overwrite Existing Files(*.bcf, *.bsm) - Selecting this check box will cause the 
Conversion Utility to overwrite any .bcf or .bsm files with the same name as the 
ones being produced. If this check box is not selected, the files are still created but 
the file names will have the date and time added to them to provide uniqueness.

• Start Button - This will begin the Conversion Process. A progress Bar will open 
showing the conversion progress. 

• Cancel Button - This will close the Conversion Utility window.

Note:  There are two ways to convert a single V2.2 Notebook or Rules file. 

1. The V2.2 file can be opened with Build for Windows V2.3 and saved as a 
V2.3 Build Configuration or Style Mapping file, see Chapter 5 Using Build 
for Windows.

2. The V2.2 file can be converted from the command line, see section 
2.4.2 “Launching from a Command Line” on page 8.
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2.4.2 Launching from a Command Line
This section describes how to start and use the Conversion Utility from a DOS 
Command Prompt. The following features are available from the command line.

• Start the Conversion Utility

• Convert a single V2.2 Notebook or Rules file

• Convert all V2.2 Notebook and Rules files in a specified directory

• Display a summary of the command line features

To use any of the command line features first follow these steps.

1. Open a DOS Command Prompt.

2.  Navigate to the Build for Windows install directory. If Build for Windows is installed 
in the default directory, type:

cd "Program Files\IBM\IBM BookManager Build\bin"

Note:  The Conversion Utility does not remove any Version 2.2 Notebook or Rules 
files after sucessful conversion. 

2.4.2.1 Start the Conversion Utility:  This feature will launch the Conversion 
Utility's application exactly in the same way as selecting the File Conversion Utility 
Icon from the Start Menu.

Syntax:

To start the Conversion Utility from a command line, at the prompt type:

ezwcnvrt

2.4.2.2 Convert a Single V2.2 Notebook or Rules 
File:  This feature will convert one V2.2 Notebook or Rules file to it's corresponding 
V2.3 Build Configuration or Style Mapping file. The new V2.3 file will be in the same 
directory and have the same name, but will have a different file extension, .bcf or .bsm 
instead of .nbk or .rul respectively. If a V2.3 file exists with the same fully qualified 
name as the new V2.3 file, then the date and time will be added to the beginning of the 
new V2.3 file name. If the -o option is used and a V2.3 file exists with the same fully 
qualified name as the new V2.3 file, the old V2.3 file will be replaces by the new V2.3 
file.

Syntax:

To convert a V2.2 Notebook file, at the DOS Prompt type:

ezwcnvrt -o -nbk filename

To convert a V2.2 Rules file, at the DOS Prompt type:

ezwcnvrt -o -rul filename

• Where -o is an optional parameter. If used, any old V2.3 Build Configuration or 
Style Mapping file with the same fully qualified name as the new V2.3 file, will be 
replaced by the new V2.3 file. Otherwise, the new V2.3 file will have the date and 
time added to its file name. 

• Where filename is the fully qualified path name of the V2.2 file to be converted.
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Examples:

• ezwcnvrt -nbk "C:\Program Files\IBM\Bookmanager\Build\notebook\templwp.nbk"

• ezwcnvrt -rul "C:\Program Files\IBM\Bookmanager\Build\rules\templwp.rul"

• ezwcnvrt -o -nbk "C:\Program 
Files\IBM\Bookmanager\Build\notebook\templwp.nbk"

• ezwcnvrt -o -rul "C:\Program Files\IBM\Bookmanager\Build\rules\templwp.rul"

2.4.2.3 Convert all Version 2.2 Notebook and 
Rules Files in a Specified Directory:  This feature will convert any Version 
2.2 Notebook or Rules files found in a specified directory. The new V2.3 files can all be 
placed in a different directory if desired. If a Version 2.3 file exists with the same fully 
qualified name as the new V2.3 file, the date and time will be added to the beginning 
of the new V2.3 file name. If the -o option is used and a V2.3 file exists with the same 
fully qualified name as the new V2.3 file, the old V2.3 file will be replaced by the new 
V2.3 file.

Syntax:

To convert all V2.2 files in a specified directory, at the DOS Prompt type:

ezwcnvrt -o -s sourceDirectory -t destinationDirectory

• Where -o is an optional parameter. If used, any old V2.3 Build Configuration or 
Style Mapping file with the same fully qualified name as the new V2.3 file, will be 
replaced by the new V2.3 file. Otherwise, the new V2.3 file will have the date and 
time added to the beginning of its file name. 

• Where sourceDirectory is the name of the directory containing V2.2 Notebook and 
Rules files.

• Where destinationDirectory is the destination directory of the new V2.3 Build 
Configuration and Style Mapping files. This can be the same as the 
sourceDirectory.

Examples:

• ezwcnvrt -s "C:\Program Files\IBM\BookManager\Build\notebook\" -t "C:\Program 
Files\IBM\BookManager\Build\notebook\"

• ezwcnvrt -s "C:\Program Files\IBM\BookManager\Build\notebook\" -t "C:\My Build 
Configuration Files\"

• ezwcnvrt -o -s "C:\Program Files\IBM\BookManager\Build\notebook\" -t 
"C:\Program Files\IBM\BookManager\Build\notebook\"

• ezwcnvrt -o -s "C:\Program Files\IBM\BookManager\Build\notebook\" -t "C:\My 
Build Configuration Files\"

2.4.2.4 Display a Summary of the Command 
Line Features:  This feature will display a summary of the command line usage 
for the Conversion Utility.

Syntax:

ezwcnvrt -h

Example:
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Figure  2-2. Command prompt Window
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Chapter 3. Starting Build for Windows

This chapter describes how to start BookManager Build for Windows. You can start 
Build for Windows from either the Windows Start Menu or the DOS Command Prompt.

3.1 Starting from the Windows Start Menu
1. On the Windows Task Bar, click on Start->Programs->IBM BookManager Build-

>Build 2.3.    

2. Select the Build 2.3 icon. The first time you start Build for Windows, an untitled 
build configuration file is opened. After that, each time you start Build for 
Windows, the build configuration file that was active most recently is opened. 

3.2 Starting from a Command Line
This section describes how to start and use Build for Windows from a DOS Command 
Prompt. 

To start Build for Windows from a command line: 

1. Open a DOS Command Prompt.

2. Navigate to the Build for Windows install directory. If Build for Windows is installed 
in the default directory, typically you would type: cd "Program Files\IBM\IBM 
Bookmanager Build\bin"

3. Type buildwp to start Build for Windows. 

See Advanced Command Line Features for a detailed description of all command line 
features including using Build for Windows in "Batch" mode.

Note: Build for Windows will open the last Build Configuration File used or will create 
a new Configuration File called Untitled.bcf if the last one can not be found. 

3.3 Getting Started with BUILD for Windows V2.3
Starting the Build for Windows V2.3 program

After starting Build for Windows, you are ready to create Build Configuration Files and 
build soft copy books. 

1. From Windows Start, select Programs.

2. Select IBM BookManager Build, then Build 2.3.
The IBM BookManager Build panel will be displayed

3. From the File drop-down menu, select Open.
The Open panel will be displayed.

4. From the Look in drop down menu, select a directory containing Build 
Configuration files (*.bcf). Select from the list of Build Configuration files the file 
you wish to open, and click Open. 
Some demonstration bcf files have been installed in:
[drive]:\Program Files\IBM\IBM BookManager Build\Notebook.

5. You can either accept the pre-selected Source, Destination and Style Mapping 
files, or change them by selecting the Browse buttons associated with the 
respective windows. (This will display another Open panel, allowing you to repeat 
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step 4 to locate an appropriate Source, Destination (.boo), and Style 
Mapping(*bsm) files. Some demonstration files have been installed in: 

• [drive]:\Program Files\IBM\IBM BookManager Build\Source

• [drive]:\Program Files\IBM\IBM BookManagerBuild\Rules

6. From the Build drop-down menu, select Build.

7. If you would like your built book to be immediately displayed, select the Options 
drop-down menu, then select Build Options. The BookManager Build Options 
panel will be displayed. Click on Start SoftCopy Reader, then Apply, and OK. 
Repeat step 6.

For more information about Build for Windows files, see Chapter 4, “Working with 
Build for Windows Files” on page 13. 

For information about using Build for Windows functions or performing Build for 
Windows procedures, see Chapter 5, “Using Build for Windows” on page 17.   
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Chapter 4. Working with Build for Windows Files

This chapter describes the Build for Windows files and the information you can specify 
in them. 

Build for Windows has two files which you can use to specify information for Build for 
Windows to use. These files are defined as follows: 

Build Configuration File
A Build for Windows "build configuration file" identifies the:

•  Source document you are building

• "Style mapping file" that Build for Windows should use

• Name of the softcopy book to be built

• Any additional document elements you want Build for Windows to include 
in the softcopy book

Build Style Mapping File
The Style Mapping File determines how Build for Windows maps style 
elements in a source document for display in a softcopy book.

4.1 Build Configuration File - for Specifying Document Information 
A build configuration file contains the information necessary for Build for Windows to 
build a softcopy book. You can create as many build configuration files as you need. 
You use only one build configuration file when building a softcopy book. You can 
access the build configuration files using the File pull-down menu.

The following list describes the sections in a build configuration file and the information 
you can specify from them:

Sections of the build configuration file: 

General -
Specifies the filenames of the: 

• Source document

• Softcopy book to be created

• Style mapping file

Details -
 This section is divided into two sections that specify additional document 
elements you want Build for Windows to include in the softcopy book. 

1. The first page specifies whether to include a table of contents, list of 
figures, and list of tables.

2. The second page specifies whether to include a title page with the title, 
author's name, and other information.

 

Options -
Specifies additional processing options, such as whether to include graphics.

Messages -
Contains messages Build for Windows issues for the most recently built 
softcopy book associated with a build configuration file.
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4.2 Style Mapping File - for Defining Element Mapping 
Before building softcopy books, you must define how you want Build for Windows to 
map certain document elements in your source document. These element mapping 
rules ensure that document elements which BookManager READ handles in a 
specific way are built correctly. For example, you can specify how you want Build for 
Windows to map certain text in your source document, such as a heading, caution, or 
figure caption. In the softcopy book, these document elements are either displayed in 
a specific way, or they have hypertext linking capabilities.

You must specify that you want Build for Windows to map an element based on a 
word-processing style used to format the element. The element map rules for a 
particular source document are defined in a "style mapping file".

You can access style mapping files from the Style Mapping pull-down menu. 
Although you can create as many style mapping files as you want, you can use only 
one of these style mapping files for each softcopy book you build.

For example, you might have several documents all produced from Microsoft Word, 
but each one uses a different set of styles. In this case, create separate style mapping 
files containing rules for recognizing document elements in each document. Specify 
the style mapping file and source document when building each softcopy book.

As another example, you might have several source documents that all use the same 
set of styles. In that case, you can create one style mapping file for all these source 
documents.

The following list describes the sections in a style mapping file and the information you 
can specify in them:

Sections of a style mapping file: 

Headings - Defines how Build for Windows maps headings in the source document.

Examples - Defines how Build for Windows maps examples.

Captions - Defines how Build for Windows maps figure captions and table captions.

Alerts - Defines how Build for Windows maps dangers, warnings, cautions, and notes.

Lists - Defines how Build for Windows maps glossary lists and definition lists.

Links - Defines how Build for Windows maps application launch links and cross-book 
links.

Help for Build Configuration Files

If you want to learn more about build configuration files, select one of the following items:

• Creating a build configuration file, see: 5.1.1 “Menu Bar” on page 18

• Opening a build configuration file, see: 5.1.1 “Menu Bar” on page 18

• Saving a build configuration file with a new name, see: 5.1.1 “Menu Bar” on page 18
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Hidden Text - Defines how Build for Windows defines text or sections of the document 
not to be included in the softcopy books.

  

 

Help for Style Mapping files

If you want to learn more about style mapping files, select one of the following items:

• Creating a style mapping file, see: 5.6.2 “Menu Bar” on page 28

• Opening a style mapping file, see: 5.6.2 “Menu Bar” on page 28

• Saving a style mapping file with a new name, see: 5.6.2 “Menu Bar” on page 28
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Chapter 5. Using Build for Windows

This chapter describes all of the windows that will be displayed and components found 
in Build for Windows, and how to use them. The following sections will be described:

•  5.1 “Main Window”

•  5.2 “Build Options Window” on page 21

•  5.3 “Messages Window” on page 22

•  5.4 “Build Progress Window” on page 23

•  5.5 “Build List Window” on page 24

•  5.6 “Style Mapping Window” on page 27

•  5.7 “Advanced Command Line Features” on page 31

5.1 Main Window
The main window, shown in Figure 5-1, will be the first thing you see when you start 
the Build for Windows Application. The title of the window will always be the name of 
the current Build Configuration Notebook you are working with. Build for Windows will 
always start with the last Notebook used or Untitled.bcf if the last Notebook cannot be 
found. 

Figure  5-1. Main Window - with details hidden

Figure 5-2 on page 18 shows the main window with all its components, each of which 
will be described in the following sections.
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Figure  5-2. Main Window - with details shown

5.1.1 Menu Bar
The Menu Bar consists of five pull-down menus: File, Options, Build, Style Mapping 
and the Help Menu.

File Menu

• New – Creates a new Build Configuration file, named Untitled.bcf. If you try to 
save Untitled.bcf you will be prompted for a new name. If you have made any 
changes to the current Build Configuration file you will be prompted to save those 
changes when you select New.

• Open (ctrl+O)* – Opens an existing Build Configuration file. A window will be 
launched that allows you to select a Build Configuration file from the file system. 
This selection also prompts you to save any changes made to the current Build 
Configuration file. 

Note: You can open a Build for Windows V2.2 Notebook (*.nbk) but you will have 
to save it as a V2.3 Build Configuration file (*.bcf).

• Save (ctrl+S) – Saves the current Build Configuration file.

• Save As – Allows you to save the current Build Configuration file to a new name or 
location. A window is launched that provides this ability.

• Exit – This will close the Build for Windows Application. If changes have been 
made to the current Build Configuration file, you will be prompted to save them.

Options Menu

• Show Book Details (ctrl+E) - This option is available when the book details are 
hidden, as shown in Figure 5-1 on page 17. Selecting this option will increase the 
size of the window and show the Book Details. These include Title Page, Table of 
Contents, Copyright and other information, as shown in Figure 5-2.

• Hide Book Details (ctrl+E) – This option is available when the book details are 
visible, as shown in Figure 5-2. Selecting this option will return the Main Window 
to its original state showing only the Source, Destination, and Style Mapping.

• Build Options – This option will open the Build Options Window.

• View Messages – This option will open the Messages Window. The messages 
from the last Build will be shown.
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• Clear History – This Option will clear the history of the pull-down lists for the Main 
Window. All items except the currently selected item will be removed, except for 
the item <none> were appropriate. See 5.1.3 “Data Fields” on page 20 for more 
information on using the pull-down lists.

Build Menu

• Build (ctrl+B) – This option will start the Build Process. First the Build 
Configuration data fields will be validated, then the Build Progress Window will be 
shown to monitor messages and progress. See 5.4 “Build Progress Window” on 
page 23 for more information.

• Build List (ctrl+L) – This option will open the Build List Window which allows you to 
build multiple books at once.

Style Mapping Menu

• New Style Mapping – Open up the Style Mapping Window to a new Style Mapping 
file called Untitled.bsm.

• Open [filename] – Opens the Style Mapping Window to the file indicated in the 
Main Window’s Style Mapping field. If this file does not exist the behavior is the 
same as for New Style Mapping.

• Open Other Style Mapping – This option allows you to select a different Style 
Mapping file to open, and then opens the Style Mapping Window to this file.

Help Menu

• Getting Started - Starts the IBM SoftCopy Reader for Windows program, which in 
turn opens up the "IBM BookManager Build for Windows: Getting Started" book 
(this book) to Appendix A, “Guide for Building Softcopy Books with BookManager 
Build for Windows 2.3” on page 39.

• Help (ctrl+H or F1) – (Context-sensitive Help) This Option applies to the currently 
selected window and will open up this Book to the section related to the specific 
window.

• About BookManager Build – Information pertaining to the current version and 
service level, copyright notices, and links to appropriate Web sites.

5.1.2 Toolbar
The Toolbar provides shortcuts for many of the Menu Bar items.

 New Build Configuration File - Shortcut for New Menu Item.

 Open Build Configuration File – Shortcut for Open Menu Item.

 Save Build Configuration File – Shortcut for Save Menu Item.

 Start Build Process – Shortcut for Build Menu Item.

 Open build List Window – Shortcut for Build List Menu Item.

 Help – Shortcut for the Help Menu Item.

 Show Book Details – Shortcut for Show Book Details Menu Item.

 Hide Book Details – Shortcut for Hide Book Details Menu Item.
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5.1.3 Data Fields
All of the data fields on the Main Window have a text field and a pull-down list. These 
two items are collectively called a Combo Box. You can edit the text in the text field as 
well as using Cut (ctrl-x), Copy (ctrl-c), and Paste (ctrl-v). The pull-down list maintains 
a history of the most recently used items. Some of the pull-down lists always have 
<none> as an option. In this case selecting <none> indicates that you don’t want to 
include this item in your BookManager Book. The following is a description of each 
data field.

• Source – The source field indicates the word-processing document you wish to 
build into a BookManager Book.

• Destination – The destination field indicates the name and location of the 
BookManager Book you wish to build. Unless you modify the destination field, it 
will be automatically updated when you select a Source Document. The default 
behavior for this field also enforces an eight dot three naming convention to make 
your BookManager Book compatible with other systems. See 5.2 “Build Options 
Window” on page 21 for more information.

• Style Mapping – This field indicates which Style Mapping file you wish to use 
when building your BookManager Book. See 5.6 “Style Mapping Window” on 
page 27 for more information.

The following fields are visible only by selecting "Show Book Details" from the Options 
pull-down menu.

• Table of Contents – This field (maximum of 128 characters) indicates what you 
wish to name the Table of Contents section of the Book you are building. If 
<none> is selected then no Table of Contents will be generated.

• List of Figures – This field (maximum of 128 characters) indicates what you wish 
to name the List of Figures section of the Book you are building. If <none> is 
selected then no List of Figures will be generated.

• List of Tables – This field (maximum of 128 characters) indicates what you wish to 
name the List of Tables section of the Book you are building. If <none> is selected 
then no List of Figures will be generated. 

• Title Page – This field (maximum of 128 characters) indicates what you wish to 
name the Title Page of the Book you are building. If <none> is selected then no 
Title Page will be generated. The following fields will be displayed under Title 
Page.

— Title – This field (maximum of 128 characters) is the title of the Source 
Document.

— Author – This field (maximum of 128 characters) specifies the Author of the 
Source Document.

— Document Number – This is a unique identifier for this book. Illegal characters 
include: space, tab, new line, equal sign, forward slash, backward slash, pipe, 
colon, pound, less than, greater than, ampersand, double quotation, question 
mark, plus sign, period, and asterisk. This field has a maximum of 128 
characters.

— Date – This field (maximum of 128 characters) is the last modified date of the 
source document.

— Comments – User Comments, limited to 126 characters.

• Security – This field (maximum of 128 characters) contains the Security 
Statement of the document. If <none> is selected then no security statements will 
be made.

• Copyright – This field (maximum of 128 characters) contains the Copyright 
Statement of the document. If <none> is selected then no copyright will be 
specified.
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Note:  The BookManager Readers will display either the Copyright Statement, or the 
Security Statement. In the event the Book contains both a Security Statement 
and a Copyright Statement, only the Security Statement will be displayed.

5.2 Build Options Window
The following list describes the fields in the build options window and the information 
you can specify in them. These items, except for Softcopy Reader Systems Directory, 
are stored uniquely for each build configuration file.

Dictionary - Specify the dictionary to use.

Code Page - Specify which code page to use.

Build working directory - Specify the directory that Build uses for its temporary files.

Softcopy Reader System Directory - The system directory for the Softcopy Reader 
product. Softcopy Reader is needed to view Build for window's online help and to 
verify newly created Softcopy books. 

Note:  This field is set automatically during installation and should only be changed if 
you have moved or re-installed Softcopy Reader to a new location. In this case, 
enter the new system directory or use the browse button to locate the new 
system directory. The Softcopy Reader system directory always ends with the 
directory path name component "\sys\". The default system directory is 
"C:\Program Files\IBM\SCR\sys\".

Start Softcopy Reader - If checked, starts Softcopy Reader so you can view the new 
book upon completion of build process.

Include Graphics - If checked, graphics are included in the book.

Continue with Missing References - If checked, continue the build process when 
missing references are found.

Use 8.3 Naming - If checked, enforces 8.3 naming for the destination book file. This is 
important if your book is to be viewed on many different platforms.

The Build Options Window can be accessed from the Options menu. Figure 5-3 on 
page 22 shows the Build Options Window. The build options apply individually to each 
book. They are stored in the Build Configuration file.
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Figure  5-3. Build Options Window

5.3 Messages Window
The Messages Window, shown in Figure 5-4, allows you to view the messages of the 
last Build for this Build Configuration. 

Get specific information about each message by double clicking on the message. 
The Build for Windows Messages and Codes softcopy book will be opened and you 
will be taken directly to the message. You will see an explanation of the message, 
system action, and user response (what you should do).

Figure  5-4. Messages Window 
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• Title Bar – The title bar will always show the current Build Configuration that you 
are working with. 

• Help Menu – This Menu will open up this book to the section on the Messages 
Window.

• Messages List – The Messages List shows any messages received during the 
Build Process. There are three types of messages:

— Status messages are designed to keep you informed of how the Build 
Process is progressing.

— Warning messages indicate something is wrong and generally the Build 
Process will continue.

— Error Messages indicate something is wrong and Build cannot continue 
processing.

For more information on a specific message, double click on that message and 
Softcopy Reader will display the message in the Messages and Codes book. 

5.4 Build Progress Window
When building a Softcopy book, the Build Progress Window will be displayed, see 
Figure 5-5 on page 24.   The Build Progress Window will display all the messages 
received in processing the source document and the overall progress. This section 
describes the features of the Build Progress Window.

• Title Bar - The title bar shows the approximate overall progress and the Build 
Configuration file for the Softcopy book currently being built.

• Help Menu - The Help Menu contains one item, Help -- selecting it launches the 
Softcopy Reader which displays the "Build Progress Window" section of the 
Getting Started Book.

• Message List - The message list displays all the messages received while 
processing the source document. To find out more information about a specific 
message, double click on the message. Softcopy Reader will open the Build for 
Windows Messages and Codes book to the appropriate message. For each 
message, the Messages and Codes book contains an explanation of the 
message, system action, and appropriate user response (what you should do).

• Progress Bar - The progress bar shows the approximate overall progress of the 
build process currently running.

• Cancel Button - Pressing the Cancel Button at any time during the build process 
will cancel the build process currently running. If the build has been terminated by 
the user or has completed, the Cancel Button will change to an OK Button. 
Clicking the OK Button will close the Build Progress Window. 

Note:  The Build Progress Window can not be closed as long as a build is in 
progress.
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Figure  5-5. Build Progress Window

5.5 Build List Window
The Build List Window gives you the ability to build many BookManager Books at the 
same time. Figure 5-6 shows a typical Build List Window. The rest of this section 
describes the features of the Build List Window.

Figure  5-6. Build List Window

5.5.1 Menu Bar
File Menu

• Close – This item closes the Build List Window. If a Build is in Progress, the 
window cannot be closed, it can however be minimized and the progress will show 
on the Application Icon.

Edit Menu

• Add – This menu item opens a browse window that allows you to select files to 
add to the file list.

• Remove (delete) – This menu item removes any selected files from the file list.
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• Select All – This menu item selects all the files in the file list.

Build Menu

• Build (ctrl+B) – This menu item will build the selected files from the list of files. 
When a build list starts, a Build List Progress Window will be displayed, see Figure 
5-7 on page 27

Help Menu

• User’s Guide (ctrl+H) – This menu item will launch SoftCopy Reader, which will 
display the "Build List Window" section of the Getting Started book.

5.5.2 Build List
The Build List Window is a list of Build Configuration files (.bcf). These files are kept in 
alphabetical order for ease of use. Files can be added to this list in the following ways.

• Add Menu Item – Described above in the Edit Menu section.

• Add Button – Described below in the Build List Buttons Section.

The following file selection mechanisms are provided to select the books in the list to 
build.

• Select All – This menu item found under the Edit Menu selects all the files in the 
list.

• Select One - Using the mouse you can select any one of the files in the list.

• Select Range – By holding down the Shift key you can select a range of files from 
the list.

• Select Specific – By holding down the Ctrl key you can select any number of 
specific files in the list.

Drag and Drop – The Build List Window also supports drag and drop operations from 
Windows Explorer. You can Drag and Drop single files or directories of files. You can 
do this from Windows Explorer by clicking on the file or directory you wish to add. 
Then, while holding down the left mouse button, move the mouse over the Build List 
Window and release the left mouse button. Only files with the extension .bcf will be 
added.

5.5.3 Build List Buttons
• Build Button – This button is a shortcut for the Build Menu Item. It will start the 

Build process building any selected files from the Build List Window.

• Add Button – This button is a shortcut for the Add Menu Item. It will launch a 
browse window, which allows you to add files to the Build List Window.

• Remove Button – This button is a shortcut for the Remove Menu Item. This button 
will remove any selected files

• Cancel Button – This button will close the Build List Window, it will NOT cancel a 
Build that is in progress. There will be a Cancel Button on the Build List Progress 
Window that will terminate the Build process.

5.5.4 Replace Existing Book Files - Check Box
If the Replace Existing Book Files check box is selected, then any current Book file 
with the same name and location as the Destination Field in the Build Configuration 
will be replaced with the newly created Book. If this check box is not selected and the 
above situation occurs, the new Book will not be built and an error message will be 
displayed that the Book already exists.
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5.5.5 Build List Progress Window
When the Build Process begins, the Build List Progress Window is displayed, as 
shown in Figure 5-7 on page 27. During processing, all of the messages received in 
processing the source documents and Build Configuration files will be displayed in the 
window. In addition, you will see a bar that shows the overall progress. This section 
describes the features of the Build List Progress Window.

• Minimizing - The Build List Progress Window itself cannot be minimized. But, by 
minimizing the Build List Window, both it and the Build List Progress Windows will 
be minimized. Both windows will also be displayed again if you restore the Build 
List Window.

• Help - This menu item will launch Softcopy Reader, which will display the "Build 
List Progress Window" section of the Getting Started book.

• Message List - The message list displays all the messages received while 
processing the Build Configuration File and source documents. To find out more 
information about a specific message, double click on the message. Softcopy 
Reader will open the Build for Windows Messages and Codes book to the 
appropriate message. For each message, the Messages and Codes book 
contains an explanation of the message, system action, and appropriate user 
response (what you should do).

Note: Some of the messages displayed do not have corresponding message 
numbers and therefore will not have entries in the Messages and Codes 
book. These messages are either status messages or error messages 
generated when validating the data in the Build Configuration file. These 
messages should be very explicit and understandable.

• Progress Label - The label above the progress bar states which Build 
Configuration file is being used to build the softcopy book. This label also 
indicates the number of this Build Configuration and the total number of Build 
Configuration files being built.

• Progress Bar - The progress bar shows the approximate overall progress of the 
build list process.

• Cancel Build Button - Pressing the Cancel Build Button at any time will cancel the 
build list process. If the build has been terminated by the user or has completed, 
the Cancel Build Button will change to an OK Button. Clicking the OK Button will 
close the Build List Progress Window. 
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Figure  5-7. Build List Progress Window

5.6  Style Mapping Window
The Style Mapping window defines the Source Style to Book Style mapping. To be 
more specific, Build allows you to map certain styles in your Source Document to 
styles that are supported by BookManager Books. A typical Style Mapping Window is 
shown in Figure 5-8. The remainder of this section will describe how to use the Style 
Mapping Window.

Figure  5-8. Style Mapping Window
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5.6.1 Title Bar
The title for the Style Mapping Window indicates the current Build Style Mapping file or 
Untitled.bsm (if a file name has not yet been specified).

5.6.2 Menu Bar
File Menu

• New - Creates a new Style Mapping file named Untitled.bsm. You will have to 
specify a name to save this file.

• Open (ctrl+O) – This menu item opens a Browse Window, which allows you to 
open a specific Style Mapping file. 

Note:  You can open a Build for Windows V2.2 Rules Notebook (.rul) but you will 
have to save it as V2.3 Build Style Mapping file (.bsm).

• Save (ctrl+S) – This item will save the current Style Mapping file.

• Save As – This item will save the current Style Mapping file to a file name and 
location of your choice.

• Close – This item will close the Rules Window. If any changes have been made to 
the current Style Mapping file you will be prompted to save those changes.

Style Menu

•
Source Style Menu

— New Source Style (ctrl+N) – This menu item will open the New Source Style 
Dialog, which allows you to specify a new Source Style for mapping. Double 
clicking on the Folder item Source has the same effect as selecting this item. 
The new style is added to the Source Style Tree.

— Edit Source Style (ctrl+E) – This menu item will open the Edit Source Style 
Dialog showing the style information of the currently selected Source Style. 
Double clicking on a Source Style in the Source Style Tree has the same 
effect as selecting this item.

Help menu

• Help (ctrl+H) – This menu item will launch Softcopy Reader and display the "Style 
Mapping Window" section of the Getting Started book. 

5.6.3 Book Style Tree
The Book Style Tree is a graphical representation of all the styles supported by 
BookManager Books. The styles are grouped by category. To view the styles in a 
category click on the + sign next to the Folder representing that category and the 
Folder will expand showing the styles. The Examples and Links folders are Book 
Styles, not categories for Book Styles. The styles are in the following catagories:

Category: Headings

• Level 1

• Level 2

• Level 3

• Level 4

• Level 5

• Level 6

• Level 7

• Synopsis
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• Preface

• Appendix

• Glossary

• Abstract

Category: Captions

• Tables

• Figures

Category: Alerts

• Danger

• Warning

• Caution

• Note

Category: Lists

• Definition

• Glossary (LIST)

No Category

• Examples

• Links

• Hidden Text

See 5.6.5 “Mapping Styles” for more information on using the Book Style Tree.

5.6.4 Source Style Tree
The Source Style Tree maintains a graphical representation of styles used in your 
word-processing document. You create the styles, which must be exact copies of the 
style name used in the source document. Once you create a style, it will be retained 
for later use. Style names must be mapped to Book styles on a one-to-one basis. Build 
will monitor this and inform you if there are conflicts.

Creating/Editing/Removing styles

• To create a style, select the Style>Source Style > New Style from the menu bar or 
double click on the Source Folder in the Source Style Tree.

• To edit a current style, select the style then select Style > Source Style > Edit Style 
from the menu bar or double click on the Style.

• To remove a style from the Source Style Tree, select the style then press the 
Delete key. You will be asked to confirm that you wish to delete the style.

5.6.5 Mapping Styles
To map a Source Style to a Book Style, simply drag-and-drop the Source Style from 
the Source Style Tree to the Book Style in the Book Style Tree. The mapped Style will 
show up in the Book Style Tree as a Bullet with the Style Name. The Source Style Tree 
will show the Source Style with an arrow and the Book Style it is mapped to, see 
Figure 5-9 on page 30. 
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Figure  5-9. Source Style Tree

To map this Source Style to a different Book Style drag-and-drop either the mapped 
Source Style (Bullet) or the original Source Style to the new Book Style. The Bullet will 
be removed from the old Book Style and placed under the new Book Style and the 
original Source Style will indicate the new mapping with an arrow and the new Book 
Style, see Figure 5-10. 

Figure  5-10. Book Style

Each Source Style can only be mapped to one Book Style. Each Book Style however 
can have several Source Styles mapped to it, see Figure 5-11 on page 31. To remove 
a mapped Source Style from the Book Style Tree select the mapped Source Style and 
press the Delete key. This will remove the Source Style from the Book Style Tree only, 
to remove the Source Style completely from the Rules Window select the Source Style 
in the Source Style Tree and press the Delete Key.
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Figure  5-11. Book Style - with several Source Styles

5.7 Advanced Command Line Features 
There are several advanced features for using Build for Windows from the command 
line. The following features increase the flexibly and power of Build for Windows:

•

• Start Build for Windows - opening a specific Build Configuration File.

• Start Build for Windows - opening a specific Build Configuration File and building 
the specified Softcopy book.

• Start Build for Windows - opening up the Build List Window to a number of Build 
Configuration Files and building the specified Softcopy books.

• Build a Softcopy book specified in a Build Configuration File - without starting the 
Build for Windows User Interface.

• Build a number of Softcopy books specified in a number of Build Configuration 
Files - without starting the Build for Windows User Interface.

• Display a summary of Command Line Features.

Note: When using any of the Build for Windows command line features first open a 
DOS Command Prompt and navigate to the Build for Windows installation 
directory as follows:

1. Open a DOS Command Prompt.

2. Navigate to the Build for Windows install directory. If Build for Windows is 
installed in the default directory, type:

cd "Program Files\IBM\IBM Bookmanager Build\bin"

5.7.1 Start Build for Windows - Opening a Specific Build Configuration 
File

With this option, the Build for Windows interface is opened up to the specified Build 
Configuration File. 

Syntax:
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To start Build for Windows to a specific Build Configuration File, at the DOS Prompt 
type:

buildwp filename - where filename is the fully qualified name of a Build Configuration 
File including the extension in quotation marks.

Example:

buildwp "C:\Program Files\IBM\IBM Bookmanager Build\notebook\templwp.bcf"

5.7.2 Start Build for Windows - Opening a Specific Build Configuration 
File and Building the Specified Softcopy Book

With this option, the Build for Windows interface is opened to the specified Build 
Configuration File and the Build Process is started for the Build Configuration File. As 
part of the Build Process the data in the Build Configuration File is validated and any 
errors will be reported through pop up messages. If their are no errors in the Build 
Configuration File, then the Build Progress Window is displayed where status and 
errors in processing the Source document will be displayed.

Syntax:

To start Build for Windows opening a specific Build Configuration File and building the 
specified Softcopy book, at the DOS Prompt type:

buildwp -b filename - where filename is the fully qualified name of a Build 
Configuration File including the extension in quotation marks.

Example:

buildwp -b "C:\Program Files\IBM\IBM BookManager Build\notebook\templwp.bcf"

5.7.3 Start Build for Windows - Opening up the Build List Window to a 
Number of Build Configuration Files and Building the Specified Softcopy 
Books

This option will start Build for Windows, open up the Build List Window and populate 
the list of files with any Build Configuration Files specified on the command line and/or 
with any Build Configuration Files in the directories specified on the command line. All 
the Build Configuration Files in the list of files are then selected and the Build List 
Process is started. The Build List Process will start the Build Process on each Build 
Configuration File one at a time in alphabetical order building a Softcopy book for each 
Build Configuration File. The Build List Progress Window will be displayed which will 
provide progress information, status, warning, and error messages. 

Syntax:

To Start Build for Windows opening up the Build List Window to a number of Build 
Configuration Files and building the specified Softcopy books, at the DOS Prompt 
type:

buildwp -o -bl filename(s) and or directoryName(s) 

• Where -o is an optional parameter. If you used any Softcopy books with the same 
name as the one being built, it will be replaced with the new Softcopy book, 
otherwise an error message will be displayed and the Softcopy book will not be 
built.
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• Where filename(s) and or directoryName(s) is a space separated list of Build 
Configuration Files and/or directories containing Build Configuration Files, each 
contained in quotation marks.

Examples:

• buildwp -bl "C:\Program Files\IBM\IBM Bookmanager Build\notebook\"

• buildwp -bl "C:\Configuration Files\myfile.bcf" "C:\Program Files\IBM\IBM 
Bookmanager Build\notebook\templwp.bcf"

• buildwp -bl "C:\Configuration Files\myfile.bcf" "C:\Program Files\IBM\IBM 
Bookmanager Build\notebook\" 

• buildwp -o -bl "C:\Program Files\IBM\IBM Bookmanager Build\notebook\"

• buildwp -o -bl "C:\Configuration Files\myfile.bcf" "C:\Program Files\IBM\IBM 
Bookmanager Build\notebook\templwp.bcf"

• buildwp -o -bl "C:\Configuration Files\myfile.bcf" "C:\Program Files\IBM\IBM 
Bookmanager Build\notebook\" 

5.7.4 Build a Softcopy Book Specified in a Build Configuration File - 
Without Starting the Build for Windows User Interface

This feature will Build the Softcopy book specified by the Build Configuration File 
included on the command line. The Build for Windows user interface will not be 
started. Any error messages will be sent to standard output, generally the DOS 
Command Prompt that the Build was initiated from. This option can be very useful for 
performing Builds in a "Batch" mode. That is, many such commands could be included 
in one .bat file which could be automatically run at some convenient time. The 
messages can also be captured into a file as in the second example below. In this 
case all messages reported by Build for Windows will get appended to the file 
messages.txt instead of being displayed on the monitor.

Syntax:

To Build a Softcopy book specified in a Build Configuration File without starting the 
User Interface, at the DOS Prompt type:

buildwp -o -bs filename 

• Where -o is an optional parameter. If you used any Softcopy books with the same 
name as the one being built, it will be replaced with the new Softcopy book, 
otherwise an error message will be displayed and the Softcopy book will not be 
built.

• Where filename is the fully qualified name of a Build Configuration File including 
the extension in quotation marks.

Examples:

• buildwp -bs "C:\Program Files\IBM\IBM Bookmanager 
Build\notebook\templwp.bcf"

• buildwp -bs "C:\Program Files\IBM\IBM Bookmanager 
Build\notebook\templwp.bcf" > messages.txt

• buildwp -o -bs "C:\Program Files\IBM\IBM Bookmanager 
Build\notebook\templwp.bcf"

• buildwp -o -bs "C:\Program Files\IBM\IBM Bookmanager 
Build\notebook\templwp.bcf" > messages.txt
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5.7.5 Build a Number of Softcopy Books Specified in a Number of Build 
Configuration Files - Without Starting the Build for Windows User 
Interface

This feature will Build several Softcopy books which are specified in an equal number 
of Build Configuration Files. The Build for Windows interface will not be started. Any 
error messages will be sent to standard output, generally the DOS Command Prompt 
that the Build was initiated from. This option can be very useful for performing multiple 
Builds, especially if the Build Configuration files are maintained in a common directory 
or directories. The messages can also be captured into a files as in the second 
example below. In this case all messages reported by Build for Windows will get 
appended to the file messages.txt instead of being displayed on the monitor.

Syntax:

To Build a number of Softcopy books specified in an equal number of Build 
Configuration Files without starting the Build for Windows User Interface, at the DOS 
Prompt type:

buildwp -o -bls filename(s) and or directoryName(s) 

• Where -o is an optional parameter. If you used any Softcopy books with the same 
name as the one being built, it will be replaced with the new Softcopy book, 
otherwise an error message will be displayed and the Softcopy book will not be 
built.

• Where filename(s) and or directoryName(s) is a space separated list of Build 
Configuration Files and/or directories containing Build Configuration Files, each 
contained in quotation marks.

Examples:

• buildwp -bls "C:\Program Files\IBM\IBM Bookmanager Build\notebook\"

• buildwp -bls "C:\Configuration Files\myfile.bcf" "C:\Program Files\IBM\IBM 
Bookmanager Build\notebook\templwp.bcf"

• buildwp -bls "C:\Configuration Files\myfile.bcf" "C:\Program Files\IBM\IBM 
Bookmanager Build\notebook\" 

• buildwp -o -bls "C:\Program Files\IBM\IBM Bookmanager Build\notebook\"

• buildwp -o -bls "C:\Configuration Files\myfile.bcf" "C:\Program Files\IBM\IBM 
Bookmanager Build\notebook\templwp.bcf"

• buildwp -o -bls "C:\Configuration Files\myfile.bcf" "C:\Program Files\IBM\IBM 
Bookmanager Build\notebook\" 

5.7.6 Display a Summary of Command Line Features
This option will display a summary of the Command Line Features to standard out, 
typically the computer console.

Syntax:

To display a Summary of the command line features for Build for Windows, at the DOS 
Prompt type:

buildwp -h

Example:
 34 IBM BookManager Build for Windows: Getting Started  Version 2 Release 3  



Figure  5-12. Summary of the Command Line Features
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Chapter 6. Build for Windows V2.3 Program Service

This chapter contains a description of available service for Build for Windows V2.3. It 
contains information on how long Build for Windows V2.3 will be in service, and how to 
report defects.

Product information is also available on the IBM BookManager Web site:

http://www.ibm.com/software/office/bkmgr

This Web site contains information on product fixes, product hints and tips, and free 
tools.

6.1 Type and Duration of Program Service 
Program Service for Build for Windows V2.3 will be available until November 15, 2003. 
See 6.2 “Statement of Service” for details. 

6.2 Statement of Service 
You may report defects to IBM Program Service for Build for Windows V2.3 until the 
Service Expiration Date, November 15, 2003.

A defect is defined as a code-related or documentation-related problem where the 
Program does not conform to the Program Specifications and the problem can be 
recreated in the Specified Operating Environment. Defect correction is as described in 
the Statement of Limited Warranty section.

To formally report a defect, please call: 

1. In the United States 1-800-237-5511

2. In Canada 1-800-992-4777

If you need to call for support, have the following information available:

• The product name, service level and version number which is available from 
"About BookManager Build" in the Help pull-down menu as described in 
5.1.1 “Menu Bar” on page 18.

• The kind of hardware and software being used at the time the problem occurred

• What happened and what you were doing when the problem occurred

• Whether you tried to solve the problem, and how

• The exact wording of any messages displayed, including any message number.
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A. Guide for Building Softcopy Books  with BookManager Build 
for Windows 2.3

This guide shows you step by step how to build a softcopy book with the 
BookManager Build for Windows 2.3 program.

What Build for Windows 2.3 can do for you

 Build for Windows 2.3 lets you take a formatted document, created on a PC-based 
word processing program, and convert it into an electronic "softcopy" book. Once 
converted to a softcopy book, you can use the IBM Softcopy Readers to view it online. 
You will be able to do such things as browse the book, do searches, print pages or the 
whole book, copy sections, and add book marks. You will be able to view, store and 
distribute the softcopy books on your personal computer, a network, the Web, and on 
host system terminals. 

Create your own customized softcopy book

During the Build process, the Build program analyzes the document you created with 
your word processor. It looks at the mark-up (tagging) you specified when you 
developed the document. It looks at how you marked up headings, paragraphs, tables, 
column size and other document design elements. The Build program also looks at 
what you want to have included in the document, such as a tile page, list of figures or 
tables, copyright information and other factors. 

Tell the Build program how you want your softcopy book to look

During the Build process there are two places where you can specify how you want 
your softcopy book to look. 

1. Build Window - Book Details:  When you start the Build program you have the 
option, in the expanded Book Details section, to tell the program which parts of 
the book to include. You will also be able to create a title page where you can fill in 
information about the book.

2. Style Mapping Files:  The Build program needs a Style Mapping file to tell it how 
to handle the marked up documents created with a word processor. The Build for 
Windows 2.3 program contains sample style mapping files created specifically for 
each of the word processing programs supported, see Table A-1 on page 40. The 
Style Mapping file defines how you want the Build program to map the document 
elements in your word-processor created source document into a softcopy book. 
This mapping ensures that the softcopy book produced can be viewed with the 
IBM BookManager Softcopy Readers. 

Overview of the build process:

First, you will build your softcopy book using a sample Style Mapping file which has 
the style mapping attributes for the type of word processor you used to create you 
document. Second, you will analyze the resulting softcopy book built from your 
document files and see if it meets with your satisfaction. If not, you can customize the 
Style Mapping file and re-build the softcopy book again and again until you are 
satisfied. 

1. Create a document with one of the word processing programs supported by Build 
for Windows 2.3, see Table A-1 on page 40.

2. Start the Build program.

3. Tell the Build program where the source files for your document are located.

4. Tell the Build program where to store the softcopy book after it has been built.
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5. Select the sample Build Style Mapping file for your word processor.

6. Specify features that you want to include in the softcopy book.

7. Start the Build program to do an initial build to see how your document looks after 
being built into a softcopy book with the sample style mapping file.

8. Analyze the results of your softcopy book to determine if you need to make 
changes to the sample style mapping file to create a specific look for your book.

9. Create a customized Style Mapping file for your book.

10. If you made changes to the Style Mapping file, start the Build program to build 
another softcopy book. 

11. Save the build data you specified in steps 3-9 in a Build Configuration File.

A.1 Create a Document with Your Word processor
The first step is creating the document, with all of the text, graphics and formatting 
(mark-up tags) with your favorite word processing program. In addition to the text, the 
Build program can handle a wide variety of Web-ready graphics that have been 
successfully imported into your word processor document, such as GIF, PNG, JPG, 
TIF, BMP and CGM files. In many cases people start by creating a document with their 
word processor that can be printed, then convert this into a softcopy book for online 
viewing. 

Source document types you can use to build softcopy books

With BookManager Build for Windows 2.3, you can build softcopy books from source 
documents prepared using any of the products in Table 1. 

  

 

Table A-1. Word Processors supported by BookManager Build for Windows 2.3

Word Processor Versions Comments

Adobe FrameMaker 4.0, 5.0, and 6.0 .MIF file version of 
the document only

Corel WordPerfect for DOS 5.0, 5.1, and 6.0

Corel WordPerfect for Windows Up to and including 9.0

Lotus Ami Pro for Windows 3.0 and 3.1 

Lotus WordPro 9.6 and earlier

Microsoft Word for DOS 5.0, 5.5, and 6.0

Microsoft Word for Windows 6.0 (Word95) 
7.0 (Word97, and Word2000)
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A.2 Start the Build Program Window
Start the Build for Windows 2.3 Build program.

On the Windows Task Bar of your computer, click on Start->Programs->IBM 
BookManager Build->Build 2.3, then select the Build 2.3 icon.

The Build main window will be displayed.

More information:

• Chapter 1, “Introduction to Build for Windows V2.3” on page 1 provides a more 
detailed description of the data fields in the windows.

• Chapter 3, “Starting Build for Windows” on page 11 describes different ways of 
starting Build for Windows.

• Chapter 5, “Using Build for Windows” on page 17 describes different ways to build 
softcopy books, and describes the icons on the menu bar and pull-downs on the 
build windows. 

A.3 Specify Where the Source Files for Your Document are Located
Source – The source field on the Build window indicates name and location of the 
word-processing document that you wish to build into a softcopy book.

To build a softcopy book, you must specify where your word processor text and 
graphics files are located on your computer. Enter the drive letter and file location in 
the Source field. The following example shows the source files located at C:\My 
documents\source\xxxxxxxx.doc.
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A.4 Specify where to Store the Softcopy Book after it is Built
Destination – The destination field on the Build window indicates the name and 
location of where you want to store the softcopy book after it is built. 

You must specify where you want the Build program to store the softcopy after it is 
built. Enter the drive letter and file location in the Destination field. The following 
example shows the destination file located at C:\Mydocuments\books\xxxxxxxx.boo.

A.5 Select the Sample "Style Mapping File" for the type of Word 
Processor You Used to Create the Document

You must give the Build program some guidance (rules) on how to build a softcopy 
book from the document you created on your word processor. You will do this with a 
Style Mapping File, which tells the Build program how to handle the various style 
elements used in your document. For example, in your document, did you call your 
"heading level 1" elements a Header, or a Chapter? Is “heading level 2" defined as a 
Topic or a Section? These are some of the choices you can make for your document. 
You will make these choices and selections in the Style Mapping File, which is then 
used by the Build program to convert your document into a softcopy book. 

Included in the Build program are sample Style Mapping files for each type of word 
processor supported, see Table A-2 on page 43. You may be able to use the sample 
file, designed for your word processor, (as it is) to build a softcopy book that is 
 42 IBM BookManager Build for Windows: Getting Started  Version 2 Release 3  



satisfactory to you. If there are things that you would like to change, you can 
customize the Style Mapping file to get the results you want.

The Style Mapping field on the Build window indicates which Style Mapping file you 
wish to use when building your softcopy Book.

Click on Browse to find the folder that contains the sample Style Mapping files. If you 
used the default installation settings when you installed the Build program, the sample 
files will be in C:\Program Files\IBM\BookManager\BUILD\rules\. In Table A-2, find 
your word processor then select the corresponding Style Mapping file.

  

 

In the following example, the Microsoft Word 97 word processor was used to create a 
document, so the tempmsw.bsm Style Mapping file was selected and appears in the 
Style Mapping field.

Table A-2. Sample Build Style Mapping files included with Build for Windows 3.2

Word processor Sample Build Style Mapping file

Adobe FrameMaker TEMPMKR.BSM

Corel WordPerfect 6 and earlier TEMPWP6.BSM 

Corel WordPerfect 7 and later TEMPWPT.BSM 

Lotus Ami Pro TEMPAMI.BSM 

Lotus WordPro TEMPLWP.BSM

Microsoft Word 95 TEMPMS6.BSM 

Microsoft Word 97 and later TEMPMSW.BSM 
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A.6 Specify Features that You want to Include in the Softcopy Book 
You can specify if you want the build program to include certain elements in the 
softcopy book such as table of contents, list of figures or tables, title page and more. 

Click on Options, then click on Show Book Details. 

The following Main Window - with details shown will be displayed.
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On this expanded Build window you will define which book elements you want to have 
the Build program put into your softcopy book when it gets built. You can tell the Build 
program:

• If you want a Table of Contents or <none>

• If you want a List of Figures or <none>

• If you want a List of Tables or <none>

• If you want a Title Page (with the title, author’s name, and other information), or 
<none>

• What information you want on the title page. Fill in the fields listed under Title 
Page or select <none>.

A.7 Start the Build Process to Do an Initial Softcopy Build
At this point you are ready to do an initial build using the sample Style Mapping file to 
see how the softcopy book looks. If after seeing the results of the build you want to 
make change, you can customize the Style Mapping sample file. 

Select Build on the main window tool bar, then from the drop-down menu, click on 
Build to start the build process.

As the book is being built you will see the progress in the Build Progress window 
shown below.
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A.8 Analyze the Results of the Softcopy Build
Analyze your softcopy book to determine if the results are satisfactory. Determine if 
you need to make changes to the sample style mapping file to create a specific look 
for your softcopy book. 

Does the softcopy book look satisfactory:

• YES - You are finished with the Build, go to Step A.11 “Save the Data you 
Specified in the Build Window and Style Mapping File” on page 48.

• NO - You need to customize the sample Style Mapping file for your needs, go to 
Step A.9 “Create a Customized Style Mapping File”.

A.9 Create a Customized Style Mapping File 
If, after building and analyzing your softcopy book, you determined you are not getting 
the results you want with the sample Style Mapping file as it is, you can customize it to 
meet your needs. You will use the Style Mapping File (for your specific word 
processor) supplied with the Build program as a base for creating your own custom 
Style Mapping file.

1. Make sure the Style Mapping File specific for your word processor is displayed in 
the Style Mapping field on the Build window.

2. Click on Style Mapping, then click on Open, as shown in the following window.
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After clicking on Open, you will see the following Style Mapping window which shows 
you the areas of the book that you can customize.

To use the Style Mapping window to create a custom Style Mapping file for your 
book, see Section 5.6 “Style Mapping Window” on page 27. 

More information: 

• Chapter 5, “Using Build for Windows” on page 17 describes all of the features of 
the Style Mapping window and how to make modifications to the book elements 
listed in the window. 

A.10 Build Another Softcopy Book with the Changes You Made to the 
Style Mapping File

If you made changes to the Style Mapping file (Step 7), you need to build and analyze 
the softcopy book again (possibly several times) until the softcopy book meets your 
requirements. 

Select Build on the main window tool bar, then from the drop-down menu, click on 
Build to start the build process.

As the book is being built you will see the progress in the Build Progress window 
shown below.
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A.11 Save the Data you Specified in the Build Window and Style 
Mapping File

You can save all of the settings you made, data you entered into the fields of the Build 
window, and the name of the Style Mapping file used to build the book. This will allow 
you to build similar softcopy books in the future.

To save the information in a file:

1. Click on File > Save As. A Save Configuration window will open.

2. Select the drive letter (C:, D:, etc.) and folder where you wish to store the file.

3. Assign a name and enter it into the File Name: field.

4. Click on Save. The file will be stored as a  .bcf (Build Configuration file).

You can use this Build Configuration file to build similar softcopy books in the future. 
You can create as many .bcf files as you need. You can access these files using the 
File pull-down menu.
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B. Sample Files Shipped with BookManager Build for Windows 
2.3

The following files are shipped with BookManager Build for Windows 2.3.

  

 

Word processor Source files Build Configuration  
(BCF file) 

Build Style Mapping 
(BSM file)   

Adobe FrameMaker TEMPMKR.MIF TEMPMKR.BCF TEMPMKR.BSM

Corel WordPerfect 6 
and earlier

TEMPWP6.DOC TEMPWP6.BCF TEMPWP6.BSM

Corel WordPerfect 7 
and later

TEMPWPT.DOC TEMPWPT.BCF TEMPWPT.BSM

Lotus Ami Pro TEMPAMI.SAM      
BOOKAMI.STY

TEMPAMI.BCF TEMPAMI.BSM 

Lotus WordPro TEMPLWP.LWP TEMPLWP.BCF TEMPLWP.BSM

Microsoft Word 95 TEMPMS6.DOC TEMPMS6.BCF TEMPMS6.BSM

Microsoft Word 97 
and later

TEMPMSW.DOC TEMPMSW.BCF TEMPMSW.BSM
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Glossary

This glossary defines all new terms and 
abbreviations used in this document. Definitions 
that were derived from the following sources are 
identified by the symbols indicated: 

• The American National Standard Dictionary for 
Information Systems, ANSI X3.172-1990, 
copyright 1990 by the American National 
Standards Institute (ANSI). Copies can be 
purchased from the American National 
Standards Institute, 1430 Broadway, New York, 
New York 10018. Definitions are identified by 
the symbol (A) after the definition.

• The Information Technology Vocabulary, 
developed by Subcommittee 1, Joint Technical 
Committee 1, of the International Organization 
for Standardization and the International 
Electrotechnical Commission (ISO/IEC 
JTC1/SC1). Definitions of published parts of 
this vocabulary are identified by the symbol (I) 
after the definition; definitions taken from draft 
international standards, committee drafts, and 
working papers being developed by ISO/IEC 
JTC1/SC1 are identified by the symbol (T) after 
the definition, indicating that final agreement 
has not yet been reached among the 
participating National Bodies of SC1.

References

The following cross-references are used in this 
glossary:

• Contrast with - refers to a term that has an 
opposite or different meaning.

• See - refers to multiple-word terms that have 
the same last word.

• See also - refers to related terms that have a 
similar, but not synonymous, meaning.

• Synonym for - indicates that the term has the 
same meaning as another term, which is 
defined.

A

artwork. A visual representation of a vector graphic or a 
raster image on a display screen.

American National Standard Code for Information 
Interchange (ASCII). The standard code, using a coded 
character set consisting of 7-bit coded characters (8 bits 
including parity check), that is used for information 
interchange among data processing systems, data 
communication systems, and associated equipment. The 
ASCII set consists of control characters and graphic 
characters. (A) 

author. The person who wrote or prepared the 
information in a softcopy document.

B

book. A publication or other written material. See also 
softcopy book.

BookManager Build. A group of IBM licensed programs 
that lets you create softcopy books. BookManager Build 
is available for Windows, MVS, and VM.

BookManager Read. A group of IBM licensed programs 
that let you read softcopy books. BookManager Readers 
are available for MVS, VM, AIX, AS/400, Linux, and 
Windows.

Build. The process of creating a softcopy book from a 
source document.

build configuration file. A Build for Windows file 
containing information that identifies the source 
document you are building, the Style Mapping file that 
Build for Windows should use, the name of the softcopy 
book to build, and any additional document elements you 
want Build for Windows to include in the softcopy book.

C

chapter. In BookManager, a section or part of a softcopy 
book whose topic ID begins with a major topic number, 
such as 1.0 or 4.0.

code page. An assignment of graphic characters and 
control function meanings to all code points; for example, 
assignment of characters and meanings to 256 code 
points for an 8-bit code.

collection. A set of electronic books that reside at a 
single file system location, such as D:\BOOKS. 

collection kit. A set of electronic books provided by IBM 
on a CD-ROM.

D

DLL. Dynamic link library. A module containing 
executable code that is linked at run time.

document. Synonym for source document.

document element(s). The pieces of your source 
document, such as headings, paragraphs, notes, figures, 
captions, and cross-references.

dynamic link library. A module containing executable 
code that is linked at load or run time.
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G

graphic. Pertaining to pictorial material or the output of 
graphics software, in contrast to text. Graphics in a 
softcopy book can be integrated into the text or displayed 
in a separate window.

H

hypertext. A method of accessing information in a 
nonlinear fashion by linking to more information on a 
particular graphic or idea.

hypertext link. An automatic connection between a 
document element in one part of a softcopy book to 
another document element in the same book or to 
another softcopy book. 

I

icons. Graphical representations of various document 
elements such as disk drives, applications, and 
documents. 

index. An alphabetical list of the subjects in a softcopy 
document and the topics in which each subject is found. 
Contrast with table of contents and search index.

inline image. A graphic image that appears on the same 
line as text in a document.

L

LAN. Local area network. A computer network located on 
user premises within a limited geographical area.

local area network (LAN). (1) Two or more computing 
units connected for local resource sharing. (2) A network 
in which communications are limited to a moderate-sized 
geographic area, such as a single office building, 
warehouse, or campus, and that do not extend across 
public rights-of-way.

P

page. A unit of content, usually textual, that is accessed 
in a single transaction over the World Wide Web. (May be 
the equivalent of one or many pages of printed material.) 

path. The storage location of a file. The path includes the 
drive, directory, and, if applicable, the line of 
subdirectories leading to the directory in which the file 
resides. 

R

revisions. Changes an author has made to a book. 
Revisions may be marked with revision characters. 
Readers can move through a book looking at only those 
topics that have been changed or added to the book.

S

softcopy book. A file created by BookManager Build 
from a source document. A softcopy book can be viewed 
by any of the BookManager Readers and BookServers.

Softcopy Reader. IBM Softcopy Reader is a Java-based 
online documentation reader and organizer made up of 
two programs: (1) Book Reader allows you to open 
softcopy books created with one of the IBM 
BookManager Build programs, (2) Bookshelf Organizer 
allows you to manage your books and bookshelves. 

source document. An input file that can contain text, 
formatting codes, and artwork. A document can be 
edited, printed, viewed, or used as input to a publishing 
program product such as BookManager Build.

style mapping file. A Build for Windows file containing 
the style recognition rules that determine how Build for 
Windows recognizes document elements in a source 
document and then builds them in a softcopy book.

T

table. Information presented in rows and columns and 
defined by the author as a table. 

table of contents. A list of topics in the order in which 
they appear in a book. 

topic. A heading and its subsequent text up to the next 
heading; the basic unit of information in a BookManager 
softcopy Book. 

topic heading. A heading that introduces a new topic in 
softcopy. Each topic heading is made up of two parts: a 
topic ID and a topic title. 

topic title. The title that is associated with a topic 
heading. See also topic heading. 

topics list. A list of all the topics in a softcopy document 
that have topic IDs. 

U

URL. Universal resource locator. The standard World 
Wide Web means for specifying the location of a resource 
on the Internet.

V

vector graphic. Computer graphics in which display 
images are generated from display commands and 
coordinate data. (I) (A) 

W

Web browser. A browser for reading World Wide Web 
documents. See browser.
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World Wide Web. A worldwide network of linked 
documents on the Internet that point to other documents 
on related topics. Using Netscape Navigator or other Web 

browser software, a user can navigate quickly and easily 
around the global Internet, following the pointers to topics 
of interest.
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